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Flight

Curriculum Unit Overview

Summary:


The students will learn the history and science behind flying an airplane.  This curriculum was developed in conjunction with our placement at WPAFB.  We learned the dynamics of air traffic control and what competencies contribute to running an airport. There are various career opportunities including airplane mechanic, air traffic controller, pilot, and aeronautical engineer.  This unit is designed for middle to high school students.  This unit would last 4-5 middle school days or about 900 min total plus a full day reserved for a field trip.

Big Picture:


After developing and using the skills needed, the students will give a whole school Power Point presentation on the history and dynamics of flight, plus the job competencies needed to run an efficient airport.  They will describe the different facets associated with flying and the different aspects of the many careers involved in running an airport or flying a plane.

Preparation for the Unit:


The computer lab reserved for two days.  Make reservations at a commercial airport (WPAFB) for a field trip that would last about ½-1 day.  Reservations of the technical equipment to give the whole school presentation with securing a time and place for the assembly.   

Overview:


On the following page is a summary of the unit including brief summaries of each Authentic Learning Tasks (ALT).  This table provides an overview of the tasks in the unit sections and shows how the activities in the different teaching areas relate to each other.  

FLIGHT

Curriculum Unit Summary

Section One:

History/English
Section Two:

Math/Science
Section Three:

Technology

ALT 1 –  History of Flight Timeline

Students will create a timeline of pictures and short summaries chronicling events in the history of flight.


ALT 1 – Compass Bearings
Students will measure the bearings of airplanes using a magnetic compass.


ALT 1 – Radar
Students will design a radar screen to measure bearing angles using a drawing software package such as Geometer’s Sketchpad. 

ALT 2 – Vocabulary
Students use the terms that they have learned in other lessons to complete a crossword puzzle.
ALT 2 – Vectors

Students will be able to use vectors to direct planes from city to city, using correct bearing and distance.


ALT 2 –  Excel Conversion Chart
Students will create a spreadsheet to calculate nautical miles (knots) into land miles.

ALT 3 – Field Trip
Students write a paper on their observations after visiting Hamilton/Fairfield airport.
ALT 3 – Taking Off
Students will study the dynamics of flight and performance experiments dealing with lift and drag.
ALT 3 – Power Point
Students will create a Microsoft Power Point presentation to present to the rest of the class.

Transfer Activity:

After developing and using the skills needed, the students will give a whole school power point presentation on the history and dynamics of flight, plus the job competencies needed to run an efficient airport.  They will describe the different facets associated to flying and the different aspects of the many careers involved in running an airport or flying a plane.

Section One: History/English

ALT One: History of Flight Timeline

Summary:

A timeline of pictures and short summaries chronicling events in the history of flight.

Competencies:

1. Students will be able to list events that took place in the development of manned flight and space exploration in chronological order.

2. Students will be able to report on a specific event in the history of flight.

3. Students will be able to work in a group and delegate responsibility.

4. Students will be able to compile a list of sources from which information was gathered.

Time:

· 25 minutes – discuss objectives and places to look for information

· 75 minutes – computer lab for Internet use

· 50 minutes – library for book reference

· 50 minutes – in classroom for compilation of information with groups

· 50 minutes – in classroom for group presentations

Total:  250 minutes

Material:

· Computers with Internet access.

· Worksheet listing of search engines and possible key works (student and teacher generated).

· Library with encyclopedias and assortment of books on aviation.

· Pens, pencils, markers, crayons, glue, scissors, an assortment of paper, etc. to allow students to be creative.

Instructions:

1. Students will form groups of 3-4.

2. As a class all students and teachers will make a list of starting points

a. What is the beginning of flight?  Should we start with the Wright brothers or go earlier to the first kites or even farther back?

b. What are some internet search engines to use?

c. What are some keywords to type into the internet search engines?

d. Etc….

3. Students will use time in computer lab and library to compile information.

4. Students will decide the topic of their report and “okay” it with the teacher.

5. After research time students will organize their information and develop the timeline.

6. Students will then compile both the timeline and the in-depth report.

7. Students will present a synopsis of both the process and final products to the entire class.

Evaluation:

Students will be evaluated on both the process and the final product.

The rubric to be used is attached.

Closure:

This activity, though rather large in comparison, gives students the background information related to all the other lessons in the unit.  This sets the tone for the Crossword Puzzle (Section One: ALT Two) and gives a background for learning in all of the other subject areas.

Section One: ALT One Rubric
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Section One: History/English

ALT Two: Vocabulary

Summary:

Students will apply the terms that they have learned in the flight lesson to a crossword puzzle.


Competencies:

1. Demonstrate knowledge of terms of flight. 

2. Middle to High School Level

3. Demonstrate knowledge of the spelling of the terms

Time:

30- 35 minutes

Materials:

1. Handout – crossword puzzle

2. Student’s Notebooks – listing the different terms

Instructions:

Complete the crossword puzzle, by finding the terms that match the clues.

Evaluation/ Assessment of Student’s Competency:

Students write a short paragraph using the terms that were in the puzzle. It will be rated as on a 20-point scale. 

4 - Used some of the terms and showed some understanding of the concepts

8 - Used most of the terms and showed some understanding of the concepts

12 - Used most of the terms and showed full understanding of the concepts

16 - Used all terms and showed understanding of some concepts 

20 - Used all if the terms and showed full understanding of all terms

Closure:

Class discussion – Students discuss the terms and their meanings
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Down
1. expression relating fluid and pressure



2. science designing airplanes




11. direction and length





7. study of forces and motion

14. speed of sound






10. pushes an object against a wall

15. angle measurement





6. mass times acceleration of gravity

16. resistance force to the forward motion 



5. 6076 ft per mile

9. 12:00 to 9:00 going left 





12. direction angle in degrees

8. ½ a circle

4. across a circle through the center

13. machine that tracks planes

9. 12:00 to 3:00 going right

3. 1 nautical mile per hour

Section One: History/English

Alt Three: After The Trip

Summary:

Students will visit Hamilton/Fairfield airport, then write a two-page paper on their observations and on what they learned. 

Competencies:

1. Demonstrate knowledge of flight.

2. Middle to High School level. 

3. Demonstrate the ability to observe during a field trip.

4. Demonstrate the ability to take mental notes during the field trip.

Time:

Two 30 – 40 minutes sections

Section 1 – writing a rough draft, and having another student edit it.

Section 2 – typing a final draft in the computer lab. 

Materials: 

· Paper and writing utensil

· Computer lab with a word processing program 

Instructions:

Students will write a two page paper with a minimum of 600 words and two topics from the list below.  After composing a rough draft students will exchange papers with a class mate for editing, followed by time in the computer lab for typing and formatting.

Paper Topics:
· History of flight

· Different types of planes

· Different careers in flight

· Design of airports

· Equipment used in the tower

Evaluation/Assessment of Student’s Competency:

Assessment is based on the rubric on the following page
Format: 1 – inch margins, typed double spaced and 10 to 12 font.

0
3
5




Spelling is accurate.

0
2
4
6
8
10

Correct Grammar.

0
2
4
6
8
10

Introduction paragraph with solid thesis statement.

0
2
4
6
8
10

Two or more body paragraphs that support the topics. Arguments are logical, and supported with examples.

0
4
8
12
16
20

Sentences ‘flow’ together. Ask if you don’t know what I mean.

0
2
4
6
8
10

Solid conclusion paragraph summarizes topics and content.

0
2
4
6
8
10

Used correct word count.

0
4
8
12
16
20

Correct number of topics.

0
2
4
6
8
10

Closure: 

Students will be able to use the paper of the field trip in the final presentation. 

Section Two: Math/Science

ALT One: Compass Bearings

Summary:

The position of aircraft is given in terms of the direction and distance from an observation point. Radar is used to obtain the distance and direction of aircraft. The radar set sends out radio waves that bounce off objects they meet and return to the set. A bearing is found from the direction of the radar antennae at the moment the waves return. An object picked up by radar appears on the radar screen, which is a magnetic compass, as a bright spot in a position corresponding to its actual position.

Competencies:

1. Students will be able to read a magnetic compass.

2. Students will draw rays to indicate bearings of aircraft by determining a North line.

3. Students will estimate bearing of an aircraft.

4. Students will determine and draw bearings of aircraft using a protractor.

Time:

· 10 Minutes for instruction

· 10 Minutes for questions and guided practice

· 15 Minutes for worksheet activity

· 10 Minutes for application activity

· 05 Minutes for summary

Total Time 50 minutes

Materials:

· Magnetic Compass (es)

· Worksheets

· Protractors

· Rulers

Instructions:

1. Arrange students into groups of three

2. Discuss the concept of bearing and how it is used.

3. Pass around a magnetic compass (es) and allow students to determine the magnetic north.

4. Have students physically determine bearings and walk along the bearing lines.

5. Pass out worksheets, protractors, and rulers.

6. Have students complete worksheets (allow students to help each other).

7. Discuss the application activity.

Evaluation/Assessment of Student’s Competency:

The first paper/pencil worksheet will be graded for accuracy and understanding of bearing.

The second worksheet (application) will be graded on how the student graphically displayed and explained the solution.

Closure:

Students will tell how they would explain the concept of bearing to their parents.

The concept of bearing will lead to vectors, which show the path of an aircraft in direction and distance.
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Compass Bearing

Class Practice





Name _______________

State the bearing represented by each of the following directions:

East (E)  
South (S)
West (W)
Northeast (NE)

Southeast (SE)

Southwest (SW)

Northwest (NW)

Group/Independent Practice

Draw two intersecting perpendicular lines to represent the directions N, S, E, W. Then draw rays to indicate the following bearing.

1. 010o
2. 317°

3. 135°
4. 248°

5. 275°
6. 068°

7. 210°
8. 170°

What is the bearing after each aircraft turn described?

 9. Clockwise 100° from S.

10. Clockwise 300° from E.

11. Counterclockwise 45° from SW


12.  Counterclockwise 80° from NE.

13. Clockwise 20° from W.

14. Clockwise 50° from N.

15. Counterclockwise 25° from NW.

16. Counterclockwise 60° from SE.

Use a protractor to find the bearing of the indicated points.
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17.



18.

Application of Bearing Worksheet







Name __________________________________

Plot each course, starting at point A (see at the bottom of the page). Connect consecutive points with segments.

1. From point A move 3 inches at a bearing of 045°. Label the new point B.

2. From point B move 1.5 inches at a bearing of 350°. Lable the new point C.

3. From point C move 2.25 inches at a bearing of 130°. Label the new point D.

4. Draw a segment from point A to point D.

5. What is the bearing from point A to point D? (explain)

Section Two: Math/Science

ALT Two: Vectors

Summary:

The students will be able to use what they know about vectors to direct planes on the proper bearing and distance.  

Competencies:

The students will be able to direct any plane to any city correctly.

Time:  

30-40 minutes

Materials:

· World maps

· Rulers

· Protractors

Instructions:

1. The students will work in groups of two.

2. They will have a list of ten different departure and arrival cities.

3. The students will determine the bearing and the distance needed to fly a straight course from one city to the other.

Evaluation/Assessment of Student’s Competency:

The student will submit the answers from the ten departure and arrival cities.

Closure:

Once a student knows how to tell a plane where to go, they must be able to make sure that the plane can get off the ground using lift and drag.  In discussing how planes fly you must give a description of how the pilots and air traffic controllers know where planes are flying from one destination to another.  

Section Two:  Math/Science

ALT Three: Taking Off

Summary:

The students will study the dynamics of flight and perform experiments dealing with lift and drag.

Competencies:

· The students will understand the basics of flight and lift by studying the lift equation and Bernoulli’s Theorem.  They must have an understanding of the principles and equations.

Time:

Two 55 min class periods.  The first will be the background information on Bernoulli’s Theorem and the lift formula.  The second period will be the lift experiment.

Materials:

· Worksheets and notes on the principals and theorems pertaining to lift and aerodynamics.

· 20X30 inch pieces of cardboard

· Copy paper

Instructions:

Period 1

1. The students will take notes on the fundamentals of Aerodynamics.  

2. The students will complete the worksheets on Lift Formula.

Period 2

1. The students will then hold a piece of cardboard (outside) so that the flat side is being held against the wind.  At this point discuss drag with the students.

2. The students will then take the pieces of cardboard and hold them with the edge facing the wind.  Discuss the differences between the flat side and the edge and the affects of area on drag.  

3. The students will then tilt the cardboard pieces and discuss the lift.  

4. The students will then fold the copy paper to make paper airplanes.  The students will discuss drag and lift with respect to the different airplanes the group has made.  

Evaluation/Assessment of Student’s Competency:

· The students will submit the worksheet on how to use and find certain lift requirements for different planes.

· The students will submit a lab report detailing the style of the paper airplane that was made.  They will have to submit the distance that the plane flew and the time it was up in the air.  They will submit a report detailing the affects of lift and drag on the various different types of paper airplanes flown.

Closure:

Having an understanding of how an airplane flies is critical to designing and running and airport and control tower.  

Lift Formula

Purpose:

To understand for lift formula that determines aircraft lift capabilities.

Concept:

An aircraft's lift capabilities can be measured from the following formula:

L = (1/2) d v2 s CL
· L = Lift, which must equal the airplane's weight in pounds 

· d = density of the air. This will change due to altitude. These values can be found in a I.C.A.O. Standard Atmosphere Table. 

· v = velocity of an aircraft expressed in feet per second 

· s = the wing area of an aircraft in square feet 

· CL = Coefficient of lift , which is determined by the type of airfoil and angle of attack or pitch angle. 

The pitch angle and CL are related and can be found using a Velocity Relationship Curve Graph (see Chart B below).

Exercises:

1. You are flying an F-117A fully equipped, which means that your aircraft weighs 52,500 pounds. You want to maintain equilibrium in straight and level flight at an altitude of 30,000 feet, cruising at 400 knots to conserve fuel. The aircraft's wing area is 1,140 square feet. At what pitch angle should the F-117A be set to maintain equilibrium? 

** Additional information you need to know to solve this problem:
How are knots related to mph to ft/s? See conversion below
What is air density at 30,000 feet? See following chart (I.C.A.O.). chart A
What is the relationship between CL and pitch angle?
Use following Chart B to determine this value.

INCLUDEPICTURE  \d "lift_formula1.GIF"



1 knot = 1 nautical mile per hour = 6,076 ft per hour
1 mph = 1 mile per hour = 5,280 feet per hour

(answer)
2. To maintain an altitude of 45,000 feet at a constant speed requires a pitch angle of 4° . Your F-22 weighs 56,450 pounds, with a wing area of 830 square feet. To stay in level flight , what should your air speed indicate? The new F-22 air speed is indicated in Mach speed, not in knots. 

** Additional information you need to know to solve this problem:
How does Mach speed convert from feet per second or from knots?
A pitch angle of 4° converts to what CL?
What is the density of air at 45,000 feet?

Mach 1 is the speed of sound, which varies with the air density. See the following I.C.A.O. chart (chart A) below. Mach 2 is twice the speed of sound, Mach 3 is three times the speed of sound.
Use the Velocity Relationship Curve Graph chart below, Chart B, to find the appropriate CL from the given pitch angle.
(answer)
3. At what velocity should you be traveling in the F-22 to maintain a 0° pitch angle at an altitude of 42,000 feet? Your weight is 57,600 pounds
(answer) 
4. Using the same plane (F-22) the same weight (57,600 pounds) and pitch angle, what should be its cruising speed at 36,000 feet? While descending from 42,000 feet to 36,000 feet the plane covers a horizontal distance of 40 nautical miles. What is the decent angle in degrees?
(answer) 


Chart A
I.C.A.O. Standard Atmosphere Table
   Altitude          Density     Speed of Sound

(Feet)             (d)         (Knots)

     0          .002377          661.7

 1,000          .002308          659.5

 2,000          .002241          657.2

 3,000          .002175          654.9

 4,000          .002111          652.6

 5,000          .002048          650.3

 6,000          .001987          647.9

 7,000          .001927          645.6

 8,000          .001868          643.3

 9,000          .001811          640.9

10,000          .001755          638.6

15,000          .001496          626.7

20,000          .001266          614.6

25,000          .001065          602.2

30,000          .000889          589.5

35,000          .000737          576.6

36,089*         .000706          573.8

40,000          .000585          573.8

45,000          .000460          573.8

50,000          .000362          573.8

55,000          .000285          573.8

* Geopotential of Tropopause

Created by Carol Hodanbosi
WWW pages edited by Jonathan G. Fairman - August 1996 
Please send any comments to:

Carol Galica ( Carol.A.Galica@grc.nasa.gov)

Beth Lewandowski (Beth.Lewandowski@grc.nasa.gov
Section Three: Technology
ALT One: Drawing a Radar Screen

Summary:

Students will design a radar screen using a drawing software program such as the Geometer’s Sketchpad. They will learn how to measure angles using computer commands. They will show the position of aircraft using distance and direction.

Competencies:

1. Students will be able to use the tools of drawing software.

2. Students will use radii to measure distance from a radar antenna.

2. Students will use bearing and distance to locate targets.

Time:

50 minutes

Materials:

· Computer Lab

· Drawing and Measuring Software

· Suggested guidelines for the design of the radar screen. 

· Requirements for saving and Printing Design

Instructions:

1. Use drawing software such as the Geometer’s Sketchpad to design a radar screen for tracking aircraft.

2. Follow these suggested guidelines:

Radius of radar detection:

50 to 100 miles


Distance between radar rings:

10 to 20 miles


Label bearing ray for every 30° (ex. 0°, 30°, 60°, 90°, 120°, etc.)

3. Place a “target” on the radar screen for each of these aircraft in the radar area:

A. 75 miles away at a bearing of 180°.

B. 10 miles away at a bearing of  050°.

C. 50 miles away at a bearing of  310°.

D. 33 miles away at a bearing of SW.

E. 65miles away at a bearing of 115°.

F. 45 miles away at a bearing 100° clockwise from S.

4. Students will add color, name, title, etc. as the teacher requires.

3

Evaluation/Assessment of Student’s Competency:

Student’s radar screens will be displayed in the classroom for the inspection and admiration of the class. Most projects should receive full credit and commendations if the basic guidelines are followed.

Closure:

Students’ familiarity with computer technology and bearing will be helpful in creating an Excel spreadsheet for converting miles per hour into nautical miles per hour (knots).


Section Three: Technology

ALT Two:  Excel Conversion Spreadsheets

Summary:

Students will create a spreadsheet to calculate nautical miles (knots) into land miles.

Competencies:

1. Students will be able to create and recognize a conversion formula from a table of values.

2. Students will be able to create a spreadsheet to calculate knots to miles and vice versa.

3. Students will be able to create a chart to show the relationship of knots vs. miles.

4. Students will be able to format their spreadsheet using various fonts, colors, and borders, etc. to make it look professional.

Time:

· 50 minutes class instruction (finding a conversion formula, expectations for spreadsheet)

· 75 minutes in computer lab

· 25 minutes for worksheet with questions

Materials:
· Computers with MS Excel (preferably one per student)

· Worksheet with questions for end

Instructions:

1. Students will copy two columns of numbers from the board. (One is knots, one is miles)

2. Students and teacher will work together to create a formula for conversion of knots to miles.

3. Students will be given rubric and told how they will be graded.

4. In the computer lab, students will create spreadsheet with rigid teacher instructions.

5. Then students will be given time to change the format and customize their spreadsheets.

6. Students will be given the worksheet with review questions to be completed.

7. Students will hand in spreadsheet on disk and hard copy along with questions.

Evaluation:

· Students will earn 20 points for a professional looking spreadsheet

· Students will earn 30 points for correct formulas within the spreadsheet (does it do what it is supposed to do?)

· Students will earn 2 points for each question answered correctly (10 questions)

Closure:

Each student will hang his/her spreadsheet on the walls for all to see.  Teacher will lead class to discuss what looks professional and what does not.  From this activity teacher can lead right into the Power Point activity.

Questions for Spreadsheet:

1. Explain your reasoning when you developed the conversion formula.

2. Explain the process you used to add color to your text.

3. Explain why you chose the format of chart that you did.

4. Explain the method you used to create the chart.

5. Explain why you consider your spreadsheet to be professional.

6. Describe the borders and cell colors you used.  (You must include cell names and references.)

Section Three: Technology

ALT Three: Power Point Presentation

Summary:

Students will create a Microsoft Power Point presentation to present to the rest of the class.

Competencies:

1. Students will be able to use Microsoft Power Point to create a 7-10 slide presentation.

2. Students will be able to use animation within MSPP.

3. Students will be able to use different fonts and styles to create creative presentations

4. Students will be able to insert an object (i.e. photo-scanned or digital, spreadsheet, chart, etc) into a MSPP presentation.

5. Students will be able to use time effectively (stay on task) and complete the project within the given time parameters.

Time:

· 25 minutes – discuss objectives and requirements

· 175 minutes – Computer Lab

· 50 minutes – Presentations for entire class (2-3 minutes maximum)

Total:  200 minutes

Material:

· Computers with Microsoft Power Point (preferably one per student).

· Power Point Packet with detailed instructions for all requirements

· Floppy disk(s) for each student (if no network server)

· WinZip software

· Projector and Screen for final presentations

· Sample project (on disk and/or hard copy)

Instructions:

1. Students will work individually.

2. Students and teacher will review Power Point packet, grading rubric, and any other requirements or special instructions.

3. Students and teacher will recreate the sample project together to introduce the basic functions of power point.

4. Students will be required to read the Power Point Packet for homework and choose at least two topics for their own Power Point Presentation (i.e. What I want to do this summer…, Etc.)

5. The next day they will complete a short quiz (5 min) and begin working on their presentation.  During this time the teacher will check the student’s topics and “okay” them.

6. The students will present their presentation to the entire class.  Presentations will be no less than 2 minutes and no longer then 3 minutes in length.

Evaluation:

Students will be evaluated on both the process and the final product.

The rubric to be used is attached.

Closure:

This activity will provide students with the knowledge necessary to complete their final Power Point Presentation.  Their final MSPP presentation will be the bulk of the Transfer Activity and finish the unit.

Power Point Presentation Rubric 

Element
How these elements are broken down
Points Earned
Points Possible

Power Point File
7-10 slides

10


At least 1 Object

10


At least 2 different fonts

10


At least 2 different size fonts

10


At least 1 animation

10

Presentation
Between 2 and 3 minutes

15


Coherent and Concise

15

Time Usage
Subjective

20

Total

/
100
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PowerPoint Tutorial
by David Cordes, copyright University of California 1999.   

 
Pre-requisites: You should be familiar with Microsoft Word or Word Perfect or another word processor. 

Goal: Learn how to create a PowerPoint Presentation..  

Colors:  (in the borders on the left)
· Green indicates that it requires basic skills such as clicking, double-clicking, entering text, cutting and pasting.
· Yellow indicates that more advanced Windows skills are required or that it uses something specific to Excel.

· Red indicates errors commonly occur, usually due to steps difficult to illustrate or conceptually difficult material.

 
Terminology
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Starting PowerPoint

PowerPoint should be on your computer near to where Microsoft Word is. Look for Microsoft Office also, if you can't find it. Once you start it, you will be confronted with the following in PowerPoint 97 
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Choose Blank Presentation. You will then be confronted with: 
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Choose the lower right corner for a completely blank new slide. The other layouts are shortcuts that save you time and help you look professional. However, we want to start completely blank to understand all the proceeses involved.



 
Inserting Text

This may surprise you, but you simply can not start typing anywhere. 

You first need to create a textbox. The textbox icon is on the drawing toolbar, see the picture to see which one it is: 
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Click on the textbox icon. Create a textbox by the following steps: 

· Click and hold down the mouse on the spot where you want the upper left corner of your text box to be. 

· Drag to the spot where you want the lower right corner of your text box to be. 

· Click inside the box and type your title, My First Presentation. 

The font by default is usually 24 size. This is because in presentations you want your font size to be large enough for people in the back of the room to be able to see it. In a smaller classroom size of about 30, you can probably go as small as 16 or 18, but never less than these for easy reading. 

Play: Play with the font. Try changing the size and the font. Try changing the color of the font by selecting the text and going to the Format menu and choose Font. 
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Inserting an Image

To an insert an image that you have already saved (instructions on getting an image are below), choose Picture from the Insert menu as illustrated below in the picture: 
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Now you just select the file you have already saved to disk. To actually try this, go to http://www.pathfinder.com/Life/ and save a picture from their website. (To save a picture on a web page, right click with your mouse and choose Save Image As or Save Picture As). Note: Most images on the web are copyrighted (especially those from Life magazine), it would be illegal to use them in a presentation for a class without written permission from the owner of the copyright.



 
The Background

A lot of people like to format the background of their slides which adds a touch of professionalism and can sometimes make it easier to see the word and images on the screen. 

To make the background just a color, choose Background from the Format menu. You will see a dialog box like the one below: 
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Note: If you want this to be the background for all your slides, then choose Apply to All. If you just want to make this one slide this color, choose Apply. 
  

Play: Have fun trying some different backgrounds.



 
Custom Animations

Enter two text boxes, one towards the top of the screen and one lower on the screen. When you have done that click on the top text box. Now that it is selected, go to the Slide Show menu and choose Custom Animation (see below) 
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Once you have done that you should see the following dialog box appear: (next page)
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Whether you use animation depends on the effect you are trying to achieve. Appear allows text to appear step by step when you are doing your slide show. This can be useful in a classroom if you want to make sure everyone is reading what you are presenting step-by-step. 

Play: Try choose the Appear effect on both text boxes and order it in the way you want. Also try some of the other animations to see what they do.



 
New Slide

After you finish the second slide, you will want to probably have another slide. To insert another slide, do so by choosing New Slide from the Insert Menu. To switch between slides you can use the scroll bar at the right.

 
Actually Doing Your Slide Show

To start your slide show, choose View Show from the Slide Show menu. Here is a list of the most useful commands while viewing a slide show: 

1. ? - the question mark will give you a list of all the commands that are available during a slide show. If you remember no other command remember this one. You may also right click your mouse during the presentation to see what options are available. 

2. Enter or n or right arrow- moves onto the next thing, whether it be the next animation or the next slide. 

3. p or left arrow- go back to the previous thing. 

4. Esc - ends slide show. 

5. Ctrl-P (using control and P) - turns your mouse into a pen so you can draw attention to certain items on the screen during a presentation. 

 
Other Things to Try on your own

There are many other things to try in PowerPoint, which are not hard or not useful enough to include in this handout. Let's just list a few of them so that you know they are available: 

· Drawing art on the screen - Using the drawing toolbar, you often enhance your presentations by drawing lines, boxes, or arrows. 

· Spelling check - Under the Tools menu. Important to use before doing anything in front of an audience. 

· Hide slide – You can choose to hide a slide in the Slide Show menu. This can be important if you are not sure if you will have enough time to show a slide. You can actually show the slide during your presentation by using the H key. 

· Re-order some of your slides - Choose Slide Sorter from the View menu to move entire slides around in your presentation. 

· Create notes for yourself with each slide - use the Notes Page from the View menu. 

· Create action buttons that do things, such as go to web pages or start other programs. Try Action Button from the Slide Show menu. 

Modified by Chris Riegel

Original work from  http://www.oid.ucla.edu/fipsel/tutorials/basicppt.html
Transfer Activity

Summary:

After developing and using the skills needed, the students will give a whole school power point presentation on the history and dynamics of flight, plus the job competencies needed to run an efficient airport.  They will describe the different facets associated to flying and the different aspects of the many careers involved in running an airport or flying a plane.  There will also be a guest speaker (a pilot) to explain to the students about his career. 

Competencies:

1.  The students will demonstrate knowledge of how to use and give a power point presentation.

2.  The students will demonstrate the knowledge of terms associated with flying.  

3.  The students will explain all of the different careers associated with flying.

4.  The students will explain the science of flight and how a plane flies.

Time:

This presentation should take about 30-60 min.

Materials:

· Technology to preset the power point.  

· Guest speaker

Instructions:

1. The students will be divided into six different groups.

2. Each group will be assigned a topic to present.  The topics will be: the introduction and closing of the power point presentation, the history of flight, basic math and science used to fly a plane, information regarding the field trip that the students went on, a recap of different career opportunities associated with flying an aircraft, and the introduction of the guest pilot to speak.  

Evaluation/Assessment:

· The students will be evaluated on time.  Each of the groups must present a four to six minute presentation.  They will receive 25 points in the time frame and –10 points for every minute less or more.  

· The students will also be evaluated on term usage and factual representation.  The students will receive 50 points except with every incorrect usage of a term or unclear explanation of a topic deduct points.   

· The students will also be evaluated on the actual use of power point. That portion will be worth 25 points.  Did they use the power point equipment and topics studied in ALT Two under the technology, subtracting various points for incorrect usage or non usage of one of the topics taught.

Appendix

Crossword Puzzle Key
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Lift Formula Worksheet Answers

1.  1

2.  .8 Mach

3.  1.2 Mach 

4.  1.08 Mach, 1.4

Credits

ALT One:  History of Flight Timeline


An AskERIC Lesson Plan


Author:  Cynthia Girouz, Carminati School, Tempe, Arizona


Adapted by: Chris Riegel, Hamilton High School, Hamilton, Ohio
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		Element		How these elements are broken down		Points Earned		Points Possible

		Working as a Group		Subjective				10

		List of Resources		Neat and organized alphabetically				5

				At least 5				5

				Correct MLA format				10

		Timeline Final Product		Creativity (Subjective)				5

				At least 15 events				10

				Events labelled and displayed correctly				10

		In Depth Report Final Product		Grammar and Spelling				5

				Content (subjective)				15

		Final Presentation		Everyone Speaks				5

				Between 7  & 10 minutes				5

				Discuss Process				5

				Discuss Timeline				5

				Discuss Report				5

		Total Points				/		100
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